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Epic Version February 2018: EpicCare: User Guide

Learning Legend:

New New O+0-+A

Look Feat Mew .
o0 \ eature Workflow D

Topic: Learning What'’s Different as of August 14, 2019?
Category:

- Rearrange sections within your Navigator. Previously you could only personalize the sections within the
current topic. Now, you can rearrange all sections within a certain activity (Plan activity > Wrench > Personalize

your Navigator > Drag and Drop the sections where you want).
Plan &

.+ TOPIC_WS_AMB_ORDERS_LEFT_PANE A ;i TOPIC_WS_AMB_ORDERS_RIGHT_PANE = ESSe S i Nevgalac

# Edit This Template

&= Problem List # Care Coordination Note E: SmartSets %) View keyboard shoricuts for navigalors

Search for new problem | s Add Show: [JPast Problems This section’s content is not available for preview

%2 DxReference #

Problems need attention. Go Reconcile =+

¥ Medications & Orders + Comments
# Patieni-Reporied F

@ Placing a new order?

i i ¥ -~ Diagnosis 3
Personalization & pronoss Use the Visit Taskbar at th bottom of
NeW Featu re Esotropia, left eye # ChangeDx ¥ your screen to add, edit, and sign orders « Add Order Dismiss
NaV| t at any point during a visit
ga on + Resolve  Visit: [2»

Intrinsic eczema # ChangeDx ¥ No active orders

 Resolve  Visit: 2  Mark as Reviewed| Last Reviewed by Joseph
i Scaramozza, MD on 7/6/2018 at
Accommodative esotropia # Change Dx ¥ 337PM

v/ Resole Vil B R CVS/pharmacy #0318 - PEABODY, MA - 637 LOWELL ST AT
HANNAFORD PLAZA ¢ 978-535-5465

" Mark as Reviewed ;
2 Providers

Advanced View

@ Visit Diagnoses

Search for new diagnosis < Add | Previous ~ Problems =

Common Abdominal pain Acute URI = v
—

Anun Alecaio duinit F

Continued on next page.
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A new look for Notes personalization settings (Notes > Wrench).
[ Newrewwimen

Progress Notes Speed Buttons A
+ Add + Add

I Caplion. |SOAP

When Creating New Progress Notes A
SmartPhrase
OR
SmantText
When Writing/Viewing Notes A

[J Remember the last tab | used for each NoteWriter note
[J Enable double-click to edit a note

Initial cursor position
@ Beginning of notes.
End of notes
End of my notes, beginning of athers’ notes

4 Restore Defauls | {3 Refresh SmartPhrases + Accept X Cancel

Link to the Mass.gov site to report Child Abuse or Neglect has been added to the References option from the
Hyperspace toolbar (References > Support Tools > DCF Reporting).
[Reterences - [~ NN

(@ UpToDate
£ pcHavice
Bl BCH Clinical References
& BiliTool
PPOC and BCH Guidelines *

Support Taols L4

# PPOC Senvice Desk

@ Leaming@PPOC
1. DCF Reporting

Multi Provider
Schedule (MPS)

New Look

Patient photo will always appear on the schedule, regardless of how many patients are booked. They will still
not appear if Open Slots has been enabled.

Patient

4 Bell, Tinker "Tink"

W 16y.0./F
. Wayne, Bruce
14yo. /M

Continued on next page.
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Chart Review

Contact information entered in Telephone Encounters is now visible in the preview report within Chart Review.

Encounter Status
Open
7/17/2019
Telephone Open Longwood Pediatrics
Gregory Young, MD  Mixed hyperlipidemia
Pediatrics Dx
Conversation
You routed conversation to Physician Pediatrics, MD Just now (7:16 AM)
Wayne, Marcy 6717-919-7762 t&¥ vou 1 minute ago (7:15 AM)
You 21 hours ago (9:51 AM)
Mom calling with guestions about Bruce's xray B
results - please call at home. ¥
Documentation

Cancelled appointments will show the Cancellation Comment in the report (Chart Review > Encounter tab >

Single-click appointment > Cancel Comments).
Chart Review Mo x

[ ] ni Notes  Labs Imaging Procedures Meds Media Letters Referrals  Other Orders &

&3 Refresh (7:53 AM) mZRoute [3) Review Selected [F Synopsis [/ Preview - 9 Encounter ~ More - | i Add fo Bookmarks | ¢ Lifetime

T Filters Hide Add' Visits | [] Me [] Pedistrics [] Longwood Pedialrics | [] Admissions ﬂ?,
When App Time Enc Type Description With Visit Type ~C| e a B2l mEx
Today
H 7/18/2019
Today 830AM X Appointment Canceled (Patient) | Louis Vernacchio, MD  WELL VISIT Appointment
Bruce Wayne | MRN: 40000513
Today ® Refil Mild intermitient asth 8 Gregary Young, MD
Recent Visits B Patient Information
Yesterday @ Telephone Grego Patient Name Sex Doe SSN
Wayne, Bruce Male 5/10/2005
0 071212019 @ Telephone Handoff Gregery
06/252019 900 AM Office Visit No Show Jay Campbel, NgSW 45 MiNBHEV/| | B Patient Demographics
06/05/2019 & Telephone Physician Pediatric Address Phone
1174 Bacon Street Blvd 763-447-5544 (Home)
0 05/10/2019 G Telephone Gregory Young, MD MINNEAPOLIS MN 55419
L
042912019 ® Telephone Gregory Young, MD
£ Status
04242019 9:30AM 1 Appointment No Show Physician Pediatrics, MD  WEL]
Canceled (Patient)
6 Months Ago
0 121312018 & Office Visit Louis Vernacchio, MD Cancel Comments
1211212018 & Office Visit Type 1 diabetes mellit... Michelle Lock, MD

Future appointments will show the Appointment Notes in the report (Chart Review > Encounter tab > Single-
click appointment > Encounter Information).

Continued on next page.
Updated: 7/22/2019
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Chart Review
n o

Notes

When App Time

Labs Imaging Procedures Meds Media Letters Refemmals  Other Orders

£ Refresh (7:48 AM) mZlRoute [3) Review Selected [F Synopsis [ Preview - 9pEncounter  More - | P Add to Bookmarks ‘eLiie(ime

Y Fiters [/ Hide Add1Visits | [] Me [ Pediatrics [ ] Longwood Pediatrics | [] Admissions

B e x

Fe

[ on (&

Enc Type Deseription With Visit Type ~-C ‘ ol = =N Bi=l4
Today
. 7/18/2019
Today B30AM B Appoinment | Louis Vernacchio MD  WELL VISIT Appointment
Bruce Wayne | MRN: 40000513
Today @ Refil winlerminemaslh _ Gregery Young, MD
Recent Visits B Patient Information
Patient Name Sex ooB SSN
Yesterd Teloph G Young, MD
esterday @ Telophone redery Toung. Wayne, Bruce Male 5072005
0 07122019 M Telephone Handoff Gregory Young. MD
062572019 9:00 AM Office Visit No Show Campbell, LICSW 45 MINBHEV/ | @ Patient Demographics
06/05/2019 & Telephone Address Phone
1174 Bacon Strest Bivel 763-447-5544 (Home)
@ 05/10/2019 G Telephone MINNEAPOLIS MN 55419
»
0412972019 @ Telephone Gregory Young. MD
13 Encounter Information
04242019 S30AM B Appointment No Show Physician Pediatrics, MD
Provider Department Encounter # Center
& Months Ago 7/18/2016 8:30 AM Louis Lop Peds 10142 Lopp
hio, MD
0 12132018 & Office Visit Louis Vernacchio, MD e
¥ R ialt T 4 dinkot T AMinhallal L KDY

Comments added during the uploading of a document to Media Manager will now appear in the Media tab in

Chart Review (Chart Review > Media > Single-click on document).

rFile Attached To
Patient | Encounter I Oreer | New Encounter | Ext Order |
| Patient |
-~ Document i Send Edit i ion T
Description: 6/7/17-SPOT VISION SCREENIN G Carmen Ortega Recipient Maodifier
Add PCP v
Do type: Other Status
Add My List | ~
Effective Group
Build My Lists
Expires: Location:
Clear All

Senice on:
Received date: Result

Signed by Relationship: ™ Modify result T Send mes=age

Signed date Representative Result date

Witness names 1 Comments (2500 Comments added when Abnormal:

max) p to Media -
Manager Result status
Billing provider
Resulting agency

View/Play [~ Preview pane

Accept Cancel

Continued on next page.
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hart Review,
[ 4] ﬂ; Encounters  Motes Labs Imaging Procedures Meds

) Refresh (9:21 AM) =2} Route [3) Review Selected Synopsis [ Preview ~ BB Thumbnail View P View/Play More ~ | pi Add to Bookmarks | Media Manager

Letters  Referrals  Other Orders

Y Fiters [/ Defaultfiter | [ | DNR [ ] Advance Directive [ | Patient Level [ | Encounter Level [ | Order Level

Date/Time Document Type Description Enc Date File Attached tc -2 | fo iy - NPV Hl&-1EX
2 Years Ago Al > Other - Scan on 7/12/2017 3:29 PM: 6/7/17-5POT VISION
2 0711212017 329 PM Other B/7117-SPOT VISION SCRE. Patient SC%EE:::LC;;U MMARY
Bl 05/20/2017 8:45 AM Physician Office Fi Patient Comments added when uploading/scanning to Media
. Manager
Eh 05202017 8:45 AM Physician Office C__ Patient

Review the patient’s Lifetime of care at a glance from the Encounters tab within Chart Review.
Chart Review

N ﬂ_! Notes Labs |Imaging Procedures Meds Media Letters Referrals  Other Orders F~

£ Refresh (10:40 AM) =ZJRoute [2) Review Selected Synopsis [] Preview ~
Y Filters [ Hide Add'l Visits | [ | Pediatrics [ | Pediatric Health Car... | [] Admissions
Lifetimel

17 2018

More ~ | ¥ Add to Bookmarks

Events

Problems

Accommodative esotropia

Esotropia, left eye

Intrinsic eczema

>3

~—

Molluscum contagiosum

w History

Medications

Penicillins ( 1)

@ %X

¥

A

~

r

Drag and drop sections of the SnapShot Reports within Chart Review (Chart Review > Select the report >

Wrench > Personalize the report).

IChart Review

- £ | © | [@ Peds SnapShot

Problem List #F A

M Encounters  Notes Labs Imaging Procedures Meds Media Lefters Referrals  Other Orders

Peds SnapShot

Specialty Comments

-

Add or remove buttons from toolbar

I Personalize this report I

Continued on next page.
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In Basket

Telephone &
Medication
Encounters

New Look

Columns for Medication messages have been updated with more information and consistency.

£ : Steven Mendes, MD's In

Basket > Rx Request 1 unread, 1 total

Encounter O.... Open

Sender: Shelby Fernandes, LPN Pool?: NO

LastAccessed:

Sart & Filter ¥ &

“ Patient Medication Protocol Rx Source
71312019 1:43 AM LORATAD I
Pharmacy: CVS/pharmacy #1247 - EAST WAREHAM, MA- 2992 CR... Provider: Steven Mendes, MD Controlled?:

Notification Icons available within sidebar reports.

PPOC Testa

Male, 11 y.0., 7/1/2008
MRN: 203909
Phone: 617-919-7762 (M)

PCP: Susan Wang, MD
Coverage: None

Ability to send patient a MyChart message directly from within a Telephone Encounter if the patient is active

on MyChart.
Call Intake/Plan TN
r.’ BUE References JaAppts % Change Enc ProviderDept
i Contacts Reason for Call Care Teams Verify Rx Benefits Medication Review Meds & Orders Problem List &
Chart Review
Visit Diagnoses History BestPractice Comm Mgt MyChart Msg Routing
(@ MyChart Message s
Call Intake/Plan
No messages in this encounter.

Continued on next page.
Updated: 7/22/2019
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- The Communication Management section (where letters are created) has been relocated to within the Call

Intake/Plan of Telephone Encounters for all users.
Call Intake/Plan

Wil References dayAppts & Change Enc ProvidenDept

Contacts Reason for Call Care Teams Verify Rx Benefils Medication Review Meds & Orders &
Chart Review

Problem List Visit Diagnoses History BestPractice Routing

= Communication Management

= New Communication | J&

Call Intake/Plan

I 1N Routing

- New options for Reason for Call when creating Telephone Encounters to include:
- Discharge Follow-Up — ED

Discharge Follow-Up — Inpatient Admission

- Discharge Follow-Up — Other

- Certified Letter

- Cosign - Clinic Orders report updated to include the associated Progress Note.

@ Sign Y Encounter
+ | [ Details [ visit Summary [ Help
Al 5
@& Cosign Order
E-Signature Needed
03/18/19 Appointment (No  Longwood Pediatrics Due: 3/25/2019 11:59 PM
show)
Test, Katelyn CSN: 39611
"PPOC"
Male @, 11 y.0, 07/01/2008 5 Order Info
PCP: Susan Wang, MD
Language: English amoxicillin 125 MG/5ML suspension 90 mg/kg/day (Order-Specific), @ -8
Need Interp: No PO, BID
Last Weight: 140 Ib (63.5 kg) Order Details  Cosign Rebecca Nurse, MA at 03/18/19
Phone: M: 617-919-7762 H 1216
617-919-7035 Dispense: 1960  Refills: 0 Diagnoses: Asthma with acute
Emerg Contact: Test,Ma mL exacerbation, unspecified asthma
Emerg Contact Ph: H: 617- severity, unspecified whether
918-7035 M: 781-760-8629 persistent
Sig: Take 98 mL (2,450 mg total) by mouth 2 (two) times a day for 10 days.
ALLERGIES - .
o e Reason For Exam Priority: Routine
v Dx: Asthma with acute exacerbatien, unspecified asthma severity, unspecified
Lemon Flavor whether persistent [J45.901 (ICD-10-CM)]
Peanuts (Food) comments:
Health Maintenance: Due
FYI: Critical Alert (ADVISORY)
! ] [ Progress Notes
Plan: None ;
MRN: 203809 Gregory Young, MD at 3/18/2019 1:30 PM
MyChart: Active Status: Sign at close encounter
Pharmacy: EMC Patient here with Mom
PRESCRIPTION PHARMACY
m?LRKLHVGJY‘FE%EIS nglvr 1979 After obtaining consent, and per orders of Dr. Jones, injection of MMR
THOMPSON DRUG CO. - given by Katelyn Severance, MA. Patient instructed to remain in office for
DELHI, LA - DELHI, LA - 213 20 minutes afterwards, and o report any adverse reaction to me
DEPOT STREET [10677] immediately.
Preferred Lab: None
Next Appt: None bl

Continued on next page.
Updated: 7/22/2019
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Option to Postpone messages in the Overdue Results folder.

¢ QuickActions - X Dope | X Cancel G Chart & Telephone Call [ Letter - E,‘Rasuno

+ ||[B Message [ PPOC Message [ Visits/Patientinfo [ MedsiProblems [ VitalsiLabs [ My Last Note

Follow-up Actions I General

Comment @
,(9*5| |@{_?]+ nsert SmartText & P More =

2]

Postpone @ €) Due By

Tomorrow | 1 Week

Until | De

Flags
July > 2019 »

Su Mo Tu We Th Fr Sa £ Call patient
% 1 2 3 4 508 [ Call with results

7 8 9 10 11 12 13 [ Patient reminder
14 15 16 17 g 19 20 [ Personal reminder
21 22 23 24 25 26 27 [ Schedule follow-up
28 29 30 3t 1 2 3 appoiniment

4 5 6 7 8 9 10 [ Write lefter

o + Accept ¥ Cancel

Letters

Provider Signatures: will now appear on all letters with the exception of the Health Form as long as we have
received the signature from the provider.

Electronically Signed by

"

The signature will only appear for the provider who the encounter is created with. If a clinical staff member

creates an encounter under themselves and needs to create a letter with the providers signature on file, they
will need to change the encounter provider by clicking Change Enc Provider/Dept prior to creating the letter.
Call Intake/Plan

B8 References gy Appts | & Change Enc Provider/Dept

Continued on next page.
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- Wording change to address the patient in the TB Questionnaire and updated question about Travel from 2
weeks to 1 month.

Fg Wagthe patient]born outside the United States? No

Was the patient born in Africa, Asia and Pacific Islands No
(except Japan), Central America, South America, Mexico,
Eastern Europe, the Caribbean or the Middle East?

In the past year...

Fg Has the patient lived in or traveled to Africa, Asia and AE No
Pacific Islands (except Japan), Central America, South
America, Mexico, Eastern Europe, the Caribbean or the

Middle East?
Was the duration of travel more than 1 menth? Yes il
GE Has the patient been exposed to anyone with a positve Yes JD]

TB skin test?

Was the contact sick from tuberculosis (cough, weight loss, Yes m
night sweats)?

Did the contact have addtional testing for TB disease or Yes m
treatment with medication to prevent getting sick from TB
prior to exposure to the patient?

Screenings
- SWYC has been added to Synopsis:
Synopsis
Peds General Summary ADHD Asthma Concussion Anemia/Llead S2BI/CRAFFT Anxiety/Depression Thyroid PSC17 | SWYCIMCHAT
Days 4/26/2018 7/20/2018 10/16/2018 1/15/2019
All

2 Patient Spotlight
No data to display.

IA SWYC (Survey of Well-being of Young Children]l
Development for 9,10,11 months. (Normal = 11,13,14) SCORE 16
Development for 12,13,14 months, (Nermal = 12,13,14) SCCRE 20
Development for 15,16,17 months. (Normal = 10,12,13) SCORE 18
Developmental for 18,19,20,21,0r 22 menths. (Normal » 7,9,10,12,0r 13) SCORE 18
PPSC (normal < 9) SCORE Q
Inflexibility score {normal < 3) 0 0 a
Irritability Score {normal < 3) 0 0 o]
Routine difficulty Score (normal < 3) 0 0 [u]
SWYC POSI (Mermal < 3) SCORE Q

¥ SWYC (Family Screens)

A MCHAT Score
No data to display.

¥ MCHAT Questions

Continued on next page.
Updated: 7/22/2019
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Documentation

Phonetic Name now available within Clinical Demographics screens (Demographics > Clinical Information tab >
Phonetic Name).

emographics
Contact Ir Clinical Information Additional Information Advance Directives

Patient Lists Primary Location: |LONGWOOD PEDIATRICS, LLP
_F‘rwidsr _PCP type
VERMACCHIO, LOUIS [1000020] | General

Pharmacy Preferences

CVS PHARMACY # 1071 - BROOKLINE, MA - 400 WASHINGTON ST. ¥ EpicCare Patient I Restiicted . I~ Chart abstracted

Lab Preferences Code status: Date updated
Comments
Context Code Status History

Needs interpreter? Ne Preferred language English

Phonetic Name I Ethnicity:

Race: 1 White Written language | 1 Engiish

2% vw @O+ B« 248
Permanent comments

Patient Instructions can now be added during Pre-Charting and will no longer convert the encounter if the
patient were to No Show.
Patient Instructions for Croup have been added to the Viral Respiratory Infection SmartSet:

¥ Patient Instructions

w Patient Instructions
I:‘URI (UPPER RESPIRATORY INFECTION): PEDIATRIC (ENGLISH)

[_JURI {UPPER RESPIRATORY INFECTION): PEDIATRIC (SPANISH)
[ ]BRONCHIOLITIS: PEDIATRIC (ENGLISH)

[JBRONCHIOLITIS: PEDIATRIC (SPANISH)

["]BRONCHITIS: PEDIATRIC (ENGLISH)

[_|BRONCHITIS: PEDIATRIC (SPANISH)

[]COMJUNCTIVITIS: VIRAL: PEDIATRIC (ENGLISH)

[ COMJUNCTIVITIS: VIRAL: PEDIATRIC (SPANISH)

[]COUGH: PEDIATRIC (ENGLISH)

[ |COUGH: PEDIATRIC (SPANISH)

[]CROUP: PEDIATRIC (ENGLISH)

[ JCROUP: PEDIATRIC (SPANISH)

Continued on next page.
Updated: 7/22/2019
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Custom User Dictionaries: ability to right-click on a misspelled word and use auto-correct or set ignored words,
etc.

penicillin

penicillins
penicilli
penicillium

penicidin

Add to Dictionary
AutoCorrect »

Next Field

Previous Field

SmartText

SmartPhrases v
Spell Check

Dictionaries

Find Ctrl+F
Cut

Copy

Paste

Copy to PasteBoard CHrl+E
Launch PasteBoard

SOAP note formatting changes in version 2:
- Tables removed
- Titles updated to full name and blue font

- All changes can be seen in the SOAP Note Version 2 video on Learning@PPOC (https://ppoc.csod.com)

Chief Complaint
Well Visit

History of Present lliness
Susan Richards is a Bmo female who presents to the office with her parents.

Review of Systems
| Negative except as in HPL.

Development
Social:

looks at self in mirror
Language:

responds to name
Cognitive:

brings things to mouth
Movement:

rolls both ways.

Anticipatory Guidance
ANTICIPATORY GUIDANCE - Discussed: family functioning, infant development, nutrition and

feeding, oral health and safety

Continued on next page.
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https://ppoc.csod.com/

- History activity updated headers: General, Health Supervision, and Specialty.
- Substance Use History renamed and reformatted to Substances & Gender Identity and includes the Screening
to Brief Intervention (S2Bl) and Sexual Orientation and Gender Identity (SOGI) forms.
- All changes can be seen in the Adolescent Substance Use and SOGI Form video on Learning@PPOC
(https://ppoc.csod.com).

(® substances & Gender Identity
(GEMERAL
Substance Use: Screening to Brief Intervention (S2BI)
M Edlcal (© Boston Children's Hospital 2014)
= % Previous Substance Use History
Surgical
In the past year, how many times have you used:
Fam Ily All Mever
Ell'th Tobacco (smoked, chewed)? 2. Once or twice 3. Monthly 4. Weekly or more
Previous value: No previously filed data
Vaping products (eCig, Juul, 1. Never 2. Once or twice 3. Monthly 4. Weekly or more
HEALTH SUPERVISION Hookah)
Previous value: Mo previously filed data
Sﬂdﬂl Dﬂ[:u m Entﬂ . Alcohol? 1. Never 2. Once or twice 3. Monthly 4. Weekly or more
Previous value: Mo previously filed data
SUhStHI'I ces -IEI. GE —oo Marijuana (smoked, 1. Never 2. Once or twice 3. Monthly 4. Weekly or more
vaped,edible)?
Semal HCtWIW Previous value: No previously filed data
> Other Drugs
ME"S‘]’UE' Histﬂr}r Substance Use Comments Mmooy oow | (2] 43 4
Obstetrics
Choose Gender Identity: Female Cisgenger (autofilll  Male Cisgender (autofilll  Other (open details of Gi
SPECIALTY
? Gender Identity Details
-H'E‘thma HCTIU“ Fllan |44 Restore +" Close 1 Previous

- Gender Identity information will replace patient sex on the patient header, is denoted with the icon below and

will flow into demographics.
Bell, Tinker "Tink"

16 yr 1 mo, 06/01/2003, t3

Town: BROOKLINE
Pt Type: Medically Complex

Continued on next page.
Updated: 7/22/2019
Page | 12
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Change in printing default for the After Visit Summary (AVS):

- Patients under 13 years of age = AVS with Medications

- Patients over 13 years of age = AVS without Medications

- Ability to choose what you want to print is still available. The report selected to print, will also appear in
MyChart. If nothing is printed, the AVS without Medications will be available on MyChart. As a reminder,
proxies of patients over 13 years of age do not have access to the AVS on MyChart.

Health Maintenance

New Look

In the Frequency column, for immunizations with clinical decision support information, the link to the detail
report is now labeled Imm Details instead of Sequential.
Topics that are Completed, Addressed, Aged Out, or Discontinued are now grouped into a section titled

Completed or No Longer Recommended instead of Inactive, to reflect that they might have been addressed in

the past.
Health Maintenance
# Edit Modifiers () Postpone ¥ Document Past Immunization | [ Discontinue B
Topic Due Date Frequency  Date Completed
Current Care Gaps
IHepatilis A Vaccines (2 of 2 - 2-dose series) Overdue since 3/14/2008 | Imm Detailsl 9/14/2007 3/21/2007
Upcoming
Influenza Vaccine (1) Next due on 9/1/2019 Imm Details 10/16/2013 1/25/2011 12/28/2010
Meningococcal Vaccine (2 - 2-dose series) Next due on 3/19/2020 Imm Details 5/27/2015
DTaP,Tdap,and Td Vaccines (7 - Td) Next due on 5/27/2025 Imm Details 5/27/2015 3/21/2008 6/23/2005
Completed or No Longer Recommended !
Hepatitis B Vaccines Completed Imm Details 12/20/2004 512412004 3/19/2004
Pneumococcal Vaccine Completed Imm Details 6/23/2005 9/22/2004 7/21/2004

HPV: a 3-dose regiment for HPV will be recommended in Health Maintenance for males over 21 years of age

who have not been vaccinated for HPV and are identified as having same sex partners.

Best Practice Advisory
(BPA)

Chlamydia BPA refined to only fire for women who have been marked as sexually active who have not had a
screening within 350 days. Also new button available if patient had been screened elsewhere within the year.
Screening BPAs: The alerts that fire when an abnormal screen is documented have been changed to
suggestions and do not require an acknowledgement. The alert will only fire within the encounter in which the

screen was documented.

Tufts ACO patients with a positive screen for depression will continue to receive the BPA asking if follow up
actions had been taken, however, it has been reformatted and grammatically corrected.

Continued on next page.
Updated: 7/22/2019
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Orders & Results

New Look

v This patient had a positive screen for depression. Which of the following actions were taken?

l [[] Additional Evaluation for Depression

[[]suicide Risk Assessment

[[]Rreferral to a practitioner who is qualified to diagnose and treat depression
[]Pharmacological Intervention(s)

[] Other intervention(s) or follow up for the diagnosis or treatment of depression
["] continue current treatment

[CINo action taken

Accept Cancel

Immunizations will automatically associate to a diagnosis in the Router upon signing the visit. They will also
now appear under the heading Other orders in the SOAP note.

Phygical Exam
{PPOC Exam 21167}
{Labs this visit: 21624)
Assessment and Plan
Brenchiolitis (Primary)

- Rapid sirep screen

Other orders
- DTaP HiB IPY PENTACEL combined vaccine IM

I
[ 21208 "]

Default dosing of short acting stimulants to once a day in the ADHD SmartSet have been updated based on
review of prescribing practices at the PPOC.
Quickly select an entire order group when releasing orders in Order Review by clicking the header.

Order Review - Open Orders @ > X

¥ Views - €) Discontinue 4 Release ~ [ Extend

Cor Stat Status  Order P Remz Expected Expires Authorizing Provider
Not part of any Treatment Plan I——
[2) M| Future | Hemoglobin Alc mnm 7/17/2020... | Gregory Young, MD

[2)] M | Future | Lipid panel 117 7/17/2020... | Gregory Young, MD

Continued on next page.
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- Added Frequency of Every Afternoon to list of options when prescribing medications.
amphetamine-dextroamphetamine (ADDERALL) 5 MG tablet

Product: AMPHETAMINE-DEXTROAMPHETAMINE 5 MG PO TABS
Sig Method: [T AW IS TN | Use Free Text | Taper/Ramp | Combination Dosage

Dose: 1 tablet 5mg 10mg| [15mg

Prescribed Dose: 5mg ¥

Prescribed Amount: 1 tablet

Route: Cral
Frequency: o Caily | BID |TID
Duration: 30 Doses 30 days

Starting: |7/18/2019 Ending: |8/17/2019 First Fill:

Dispense: Days/Fill: | Full (30 Days) | | 30 Days

Quantity: |30 tablet Refill: [0

Total Supply: 30 Days
[] Dispense As Written

Mark long- [ AMPHETAMINE-DEXTROAMPHETAMINE
term:

- Updated layout for Medication Dispensing information within the Order Composer to group Duration and

Dispense together.
amoxicillin 250 MG/5ML suspension

AMOXICILLIN 250 MG/5ML PO SUSR

9 i Specify Dose, Route, Frequency IRVERZETR1S
Dose: E mg/kg/day 250 mg 45 mg/kg/day [ERENGTIGTLEN
Weight Type Order-Specific

Weight: 236 kg

1,050 mg ¥

unt: 21 mL

Oral m
2 times daily m TID

10 Doses 7days RIUGEVEY 14 days 21days 30 days

Starting: |7/17/2019
Dispense Days/Fill: EESUNSIEPEVS)
Quantity: (420 mL Refill: 10 n

Total Supply: 10 Days
[[IDispense As Written

g: |7/27/2019

Aark long [JAMOXICILLIN

Continued on next page.
Updated: 7/22/2019
Page | 15




Historical Results entered through the Results Console will no longer be routed to the Authorizing Provider,
but file directly to the patients chart

The Results Console has been added to the More activity in Office Visit encounters. You can now quickly add

historical results from within a scheduled visit by launching the Results Console.

Additional Tools
#8 Care Teams
Demographics
Document List
Enter/Edit Results

~ H 2

Flowsheets

Fl

Health Maintenance
HIm

W <

Letters

MAR

Medications
MyChart Utilities
MyPatients@BCH

Order Review

® Wy

¥= Problem List
+2] Request Qutside Records

Results Console

Review Flowsheets
E7 Send Message
# Snapshot

3
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@ ppPOC

- Patients can opt into Two Factor Authentication for MyChart login (Profile > Security Settings).

[ o
b4 = = = Tinker Bell
Log Out
Tinker Health Visits Messaging Billing
o . Preferences & Info Account Settings
Security Settings P
Natifications Manage My Accounts
Change Password Patient Information Linked Apps and Devices

Your password must be different than your MyChart Username. For increased security, use a combination of numbers and letters (lowercase and
uppercase).

Current Password:

New Password:

Confirm New:

SAVE PASSWORD

Two-Step Verification Settings
Two-step verification is an additional level of security to help keep your account secure—even if someone has your password.|

TURN ON TWO-STEP VERIFICATION

- Clinical Updates added by a patient or proxy on MyChart will now be routed to the Pt Clinical Update folder of
the PCP listed in the patient’s chart. These can be filed to the chart directly or from the In Basket message by
clicking the Reconcile Clinical Update Requests button in the toolbar.

X Done | ﬁcnan|  Reconcile Clinical Update RequestsIS'_F'anem Msg EH PtFlowsheet 2R 5

MyChart

- | [H message  [F More Info [F Patientinfo [F MedsiProblems [F vitalsiLabs [F] My LastNote  [E] Help

Patient Review of Clinical Information

Problems
This clinical information was not verified, but there are updates pending review:
Reported Problems Start Date Reported By Reporter Comments
Tink Be" e Itch of eye Tink Bell testing update clinical
Female, 16 y.0. 6/1/2003 folder for TINKERBELL - to
MRN: 40000554 Louis Vernanchio
Phone: 781-908-0987 (H) Juvenile myaclonic 6/5/2019 Tink Bell please add this to my
epilepsy history
PCP: Louis Vernacchio, MD Medications
Coverage: BLUE CROSS BLU... This clinical information was not verified, but there are updates pending review:
Reported Medications Start Date Reported By Reporter Comments
predniSONE 1 MG tablet Tink Bell
delayed-release
Allergies
This clinical information was not verified, but there are updates pending review:
Reported Allergies  Start Date Reactions Reported By Reporter Comments
Food Hives, Rash Tink Bell lobster
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